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発表者

� 椎葉 雅志（しいば まさし）

� やっていること

� 以前：

EAI/BPM製品の展開、導入支援

SOA関連情報の展開

� 最近：

Camelを使って市販EAI製品の勢力図をぬりかえるべく

活動中

（といいつつ、私も Camel 初心者です！！）



発表内容

この発表では、

� Apache Camelはどういったものか？

� Apache Camelをどのように使うか？

について説明します。
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Apache Camelとは？

一言でいえば、こんなソフト（ミドル）です。

�データをうまい具合に運んでくれる

�コンピュータ同士の仲介をしてくれる



Apache Camelとは？
～歴史～
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Apache Camelとは？
～何ができるか？その１～

� 例えば、手作業を効率化

担当者

社内サーバ

外部の会社

社内サーバ

外部の会社

Camel導入前 Camel導入後

CamelCamelCamelCamel

・担当者が手作業で実施 ・Camelが自動で実施

手作業で

再投入

Camelで
自動流通



Apache Camelとは？
～何ができるか？その２～

� 例えば、スパゲティな連携を簡素化

新規サーバ

・メンテナンスが煩雑

・各システムが接続先を意識

新規サーバ

CamelCamelCamelCamel

・メンテナンスはCamelに集約
・Camelが接続先を振り分ける

JDBC

FTP

JMS

SOAP
SOAP

SOAP

JDBC

FTP

SOAP

３つの接続先

を意識

接続先は

ひとつ



Apache Camelとは？
～何ができるか？その３～

� 例えば、Camelが持っている機能を利用して…

CamelCamelCamelCamel一定間隔/決まった日時に
特定の処理を実行

ラウンドロビンでの

負荷分散

CamelCamelCamelCamel

流通データ量の制御

CamelCamelCamelCamel

シェルコマンド実行

サーバA

サーバB

・NW帯域制限
・マシンリソース制限
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Apache Camelの適用事例紹介
～その①～

� 既にそこそこの規模のシステムで稼動しています

� 案件概要

・業種：？？？

・システムカバー範囲：東日本全域

・その他：システム更改時に市販EAI製品をApache Camelへリプレース

� 特色

Apache Camelを利用し以下のプロトコルによる他システム連携を実施
・ SOAP連携
・ JDBC連携(Oracle接続)
・ JMS（Oracle Advanced Queue）連携
・ HTTP連携

� Apache Camel 導入による感想
・商用EAI製品と遜色ない生産性、品質の確保（バグ発生が少なく強化試験を実施）



Apache Camelの適用事例紹介
～その①～

� ハードウェア構成（一部抜粋）

� Apache Camelを導入するにあたり個別のハ
ード等の準備はしておらず、APサーバと同居
構成（同一VM上で動作）としている

WebWebWebWebサーバサーバサーバサーバ DBDBDBDBサーバサーバサーバサーバ

EAI/BPM/EAI/BPM/EAI/BPM/EAI/BPM/
APAPAPAPサーバサーバサーバサーバ

【EAI/BPM/APサーバ構成】
Intel Xeon E5506 2.13GHz 1P/4C×1 , 6ポートNIC×1 , 2ポートFC×1 , 内蔵ディスクなし
4GB 2Rx4 PC3-10600R-9 メモリキット×12（48GB/台）

他システムや他システムや他システムや他システムや

サブシステム群サブシステム群サブシステム群サブシステム群

他システムや他システムや他システムや他システムや

サブシステム群サブシステム群サブシステム群サブシステム群



Apache Camelの適用事例紹介
～その①～

� ソフトウェアスタック（EAI/BPM/APサーバ）
� この案件では、外部システム・内部サブシステムI/F接続
部にApache Camelを利用

� OSS製品利用の取り組み観点においては、旧システムに
おいて利用していた商用BPM製品のOSSリプレース
（jBPMへの置換）も同時に実施している
ＥＡＩモデルＥＡＩモデルＥＡＩモデルＥＡＩモデル

（Ｗｅｂアプリケーション）（Ｗｅｂアプリケーション）（Ｗｅｂアプリケーション）（Ｗｅｂアプリケーション）

ＪＲＥ６

ＪＢｏｓｓインスタンス

ＥＡＩライブラリ群ＥＡＩライブラリ群ＥＡＩライブラリ群ＥＡＩライブラリ群 ＢＰＭライブラリ群

ＢＰＭモデル

（定義・実行クラス）

ＪＢＰＭＣａｍｅｌ／ＳｐｒｉｎｇＣａｍｅｌ／ＳｐｒｉｎｇＣａｍｅｌ／ＳｐｒｉｎｇＣａｍｅｌ／Ｓｐｒｉｎｇ



Apache Camelの適用事例紹介
～その②～

� CamelとjBoss Rulesを組合せ、CEPとし
て利用。大量データの検証

クライアントクライアントクライアントクライアント

((((大量データ生成大量データ生成大量データ生成大量データ生成))))
DBDBDBDBサーバサーバサーバサーバ

Apache CamelApache CamelApache CamelApache Camel＋＋＋＋
jBossjBossjBossjBoss RulesRulesRulesRules＋＋＋＋

TomcatTomcatTomcatTomcat



Apache Camelの適用事例紹介
～その②～

� Ruleで大量データをフィルタリング

� CamelのAggregatorでメッセージ集約

【【【【RuleRuleRuleRule】】】】
条件に合致しない条件に合致しない条件に合致しない条件に合致しない

データはゴミ箱行きデータはゴミ箱行きデータはゴミ箱行きデータはゴミ箱行き

×

【【【【AggregatorAggregatorAggregatorAggregator】】】】
同じタイプの同じタイプの同じタイプの同じタイプの

データをまとめるデータをまとめるデータをまとめるデータをまとめる

DBに
書込み



Apache Camelの適用事例紹介
～その③～

� 本店最新情報の全支店一斉配信

マスターサーバマスターサーバマスターサーバマスターサーバ

支店①支店①支店①支店①

Apache CamelApache CamelApache CamelApache Camel
支店②支店②支店②支店②

支店③支店③支店③支店③

支店④支店④支店④支店④

店頭価格

最新情報

店頭価格

最新情報

店頭価格

最新情報

店頭価格

最新情報

店頭価格

最新情報

②定期ポーリング

＆

ファイル取得

③複数拠点への一斉情報配信①競合店最新価格調査による

戦略価格の決定

sftp

sftp



Apache Camelの適用事例紹介
～その④～

� ぷちジョブネット制御

あらかじめ定めておいた処理順序に従い順次一連の処理を実行する。

① 指定時間に指定ディレクトリからファイル取得

② 取得ファイルを展開し、１行毎に記載されているデータにてＤＢインサート

③ ①のファイルをリネームしバックアップディレクトリへ移動

④ ①～③の全処理完了をSOAP通信にて別サーバへ連絡

/tmp

ファイル

Apache CamelApache CamelApache CamelApache Camel

①ファイル取得

↓

②ファイル展開・ＤＢ更新

↓

③ファイル移動

↓

④完了通知ＳＯＡＰ通信

/tmp

ファイル

/backup

ファイル

移動

別サーバ別サーバ別サーバ別サーバ

insert

SOAP通信
完了受信

毎日AM1:00に起動



Apache Camelの適用事例紹介
～その⑤～

� サービス・メディエーション

サーバＡサーバＡサーバＡサーバＡ

顧客管理顧客管理顧客管理顧客管理

Apache CamelApache CamelApache CamelApache Camel

サーバＢサーバＢサーバＢサーバＢ

料金管理料金管理料金管理料金管理

複数サーバ、複数ステップに跨る情報を一元的に収集し提供を行う。

SOAP

REST

①顧客名、連絡先情報にて

顧客管理システムへアクセスし、

共通顧客ＩＤを取得

②顧客ＩＤにて料金管理システムへ

アクセスし、料金情報を取得

③顧客ＩＤにてＳＯ管理システムへ

アクセスし、ＳＯ履歴を取得

④呼び出し元へ②、③の情報を返却

サーバＢサーバＢサーバＢサーバＢ

ＳＯ管理ＳＯ管理ＳＯ管理ＳＯ管理

REST

HTTP

・顧客名

・連絡先

・料金情報

・ＳＯ履歴
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Camel概要
～特徴～

� Enterprise Integration Pattern (EIP)

� 優れた拡張性

� 多数のコンポーネント



Camel概要
～Enterprise Integration Pattern (EIP)～

メッセージルーティングメッセージルーティングメッセージルーティングメッセージルーティング

メッセージメッセージメッセージメッセージ

メッセージ変換メッセージ変換メッセージ変換メッセージ変換
分割分割分割分割

エンタープライズ統合

のノウハウ

汎用的な

パターン

メッセージチャネルメッセージチャネルメッセージチャネルメッセージチャネル

必要な機能を定義 利用時の留意点を定義

⇒⇒CamelCamelでは多くのでは多くのEIPEIPのパターンが実現可能のパターンが実現可能

汎用的な設計パターンをGoFデザインパターンとして
定義したように、エンタープライズ統合のパターンを定義



コ

ア

機

能

Camel概要
～優れた拡張性１/２～

� 必要なコンポーネントのみ利用可能

� 不要なコンポーネントは使わなくてよい

� ない場合は自分で作成可能

Apache
CXF SOAP

Jetty

Apache
ActiveMQ

HTTP

ＪＭＳ

CamelCamelCamelCamelが提供が提供が提供が提供 他他他他OSSOSSOSSOSS
を利用を利用を利用を利用

File
ファイル

コンポーネント

判例

：コンポーネント

：OSS/ライブラリ

Webサービ
ス用Lib

HTTP用
Lib

JMS用
Lib

自作

Lib OSS Lib
個別

プロトコル



Camel概要
～優れた拡張性２/２～

� 単純なプロトコルスタック

� コア機能は他ライブラリの依存性が低い

� 他システムへの組込み/組合せが容易

� ESB、CEPやEAI/BPMへの拡張が可能

http://servicemix.apache.org/architecture.htmlより引用

オープンソース

ESBの
ServiceMixの場合

Camelと他OSSを
組み合わせて実現



Camel概要
～多数のコンポーネント １/２～

� １００以上のコンポーネント

AHC

AMQP

APNS

Atom

AWS-SNS

AWS-SQS

AWS-S3

Bean

Bean Validation

Browse
Cache

Cometd

Context

CXF

CXF Bean

CXF RS

DataSet

Direct

DNS

EJB

EventAdmin Exec

File

Flatpack

FreeMarker

FTP

Hazelcast
HDFS

HL7

HTTP

HTTP4

iBATIS
IMap

IRC

JBI

JCR

JMS

JMX

JPA

JT/400

Kestrel

LDAP

Log

Lucene

Mail

MINA

Mock
MyBatis

Netty

POP

Quartz

RMI

RSS

Sip

SFTP

SERVLET

SMPP

SMTP

SNMP

SpringIntegration

SQL

Stream

StringTemplate
TCP

Test
Timer

XQuery

連携用のコンポーネント 役立ちそうなコンポーネント EIPのコンポーネント

Event



Camel概要
～多数のコンポーネント ２/２～

� AWS,GAE等、注目のクラウド環境にも対
応

Apache CamelApache CamelApache CamelApache Camel

S3 SNS SQS
OAuth Mail Service

Amazon
Web
Service

Google
App
Engine

Task Queuing Service URL Fetch Service

コア機能

HTTP用
Lib

AWS用
Lib

Apache CamelApache CamelApache CamelApache Camel

コア機能

HTTP用
Lib

GAE用
Lib

HTTP用
Lib



� Apache Camelとは？

� Apache Camelの適用事例紹介
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CamelCamelCamelCamel

Camelの使い方

使い方の概要

① Camelコンテキストを作成（おまじない）
② 全体の処理の流れをルーティングとして定義

③ ルーティング内の個々の処理をコンポーネント(部品)で実現
④ 実行時、定義済みのルーティングに従い、メッセージが流通

JMSJMSJMSJMS

WS
コネクタ

チェック

JDBC
コネクタ

JMS
コネクタ

データ

変換

SOA
P

JDBC

振分け

データ

変換 JMS

④④④④メッセージメッセージメッセージメッセージ

③部品

(コンポーネント)

実際はJavaもしくはSpring用XMLでルーティングを定義

②ルーティング

①Camelコンテキスト



Camelの使い方
～ルーティング～

� DSLでルーティングを定義
� DSL：Domain Specific Language

Camel固有のルーティング記述用の言語

� 複数のDSLでルーティング定義が可能
� Java DSL

� Spring DSL

� Scala DSL



Camelの使い方
～ルーティング～

� ルーティングの基本

<Java DSLで記述> <Spring DSLで記述>

from(“コンポーネント１情報”)
.to(“コンポーネント２情報”)
.to(“コンポーネント３情報”)
.to(“コンポーネント４情報”);

<route>
<from uri=“コンポーネント１情報” />

<to uri=“コンポーネント２情報” />
<to uri=“コンポーネント３情報” />
<to uri=“コンポーネント４情報” />

</route>

CamelCamelCamelCamel

コンポー

ネント１

コンポー

ネント２

コンポー

ネント４

コンポー

ネント３

処理の処理の処理の処理の

順番順番順番順番

コンポーネント情報を順番に並べる。最初がfrom、それ以降はtoでつなげる

処理の処理の処理の処理の

順番順番順番順番

入力 出力

※：from、to以外にもCamelではDSLを定義している（choice, when, wireTap, etc.)



CamelCamelCamelCamel

Camelの使い方

使い方の概要

① Camelコンテキストを作成（おまじない）
② 全体の処理の流れをルーティングとして定義

③ ルーティング内の個々の処理をコンポーネント(部品)で実現
④ 実行時、定義済みのルーティングに従い、メッセージが流通

JMSJMSJMSJMS

WS
コネクタ

チェック

JDBC
コネクタ

JMS
コネクタ

データ

変換

SOAP

JDBC

振分け

データ

変換 JMS

③部品

(コンポーネント)



Camelの使い方
～コンポーネント～

� コンポーネントはURIで指定

/tmp/abcフォルダを5秒間隔でポーリング

file:/tmp/abc?delay=5000

/tmp/abcフォルダを5秒間隔でポーリング

file:/tmp/abc?delay=5000

スキーマ名：必須項目[？オプション]

コンポーネントを

識別するユニーク

な名前

URIの必須情報 ・URIのオプション情報(複数記述可能)
・複数記述する場合は‘＆’でつなげる

<URIの基本>



Camelの使い方
～コンポーネント～

� オプション指定で更に便利に！

file:/tmp/abc?delay=5000&move=.donefile:/tmp/abc?delay=5000&move=.done

file:/tmp/abc?delay=5000&recursive=truefile:/tmp/abc?delay=5000&recursive=true

処理後、.doneディレクトリに
ファイルを移動したい

フォルダを再帰的に

ポーリングしたい

新たな要件の追加



Camelの使い方
～コンポーネント～

� 各種プロトコルに対応したコンポーネント

� 書式はすべて「スキーマ名：必須項目？オプション」

� プロトコル個別のお作法を学ぶ手間が低減

log:loggingCategory[?options]-Log

jdbc:dataSourceName[?options]JDBCJDBC

ghttp://hostname[:port][/path][?options] ghttp:///path[?options]URL fetch service
(Google App Engine）

GHttp

aws-s3://bucketname[?options]Amazon Simple Storage
Service(S3)

AWS-S3

jms:[queue:|topic:]destinationName[?options]JMSJMS

jetty:http://hostname[:port][/resourceUri][?options] HTTP（サーバ)Jetty

ftp://[username@]host[:port]/directoryname[?options]FTP/SFTP/FTPSFTP/SFTP/FTPS

file:fileOrDirectoryName[?options]FileFile

cxf:address[?serviceClass=...]WebサービスCXF

URIプロトコルコンポーネント

URIの記述例



CamelCamelCamelCamel

Camelの使い方
～ルーティング例～

� ルーティングの記述例

� 他システムへのファイル送信

File
コネクタ

File
コネクタ

from(“file:/a/b”)
.to(“log:testlog”)
.to(“ftp:/receive”);

<route>
<from uri=“file:/a/b” />
<to uri=“log:testlog” />
<to uri=“ftp:/receive” />

</route>

<Java DSLで記述した場合> <Spring DSLで記述した場合>

※：ルーティング部分にフォーカスを当て、前後の処理は省略。以降も同様

他システム

FTP

/a/b/test.txt test.txt

/receiveLog出力



CamelCamelCamelCamel

Camelの使い方

使い方の概要

① Camelコンテキストを作成（おまじない）
② 全体の処理の流れをルーティングとして定義

③ ルーティング内の個々の処理をコンポーネント(部品)で実現
④ 実行時、定義済みのルーティングに従い、メッセージが流通

JMSJMSJMSJMS

WS
コネクタ

チェック

JDBC
コネクタ

JMS
コネクタ

データ

変換

SOAP

JDBC

振分け

データ

変換 JMS

④④④④メッセージメッセージメッセージメッセージ



Camelの使い方
～内部で流通するメッセージ形式～

� メッセージの話をする前に、少しだけ一般論

厳密に型を定義厳密に型を定義厳密に型を定義厳密に型を定義 利用者が型の内容を意識利用者が型の内容を意識利用者が型の内容を意識利用者が型の内容を意識

入力

処理

処理X
出力

処理

入力

処理

処理X
出力

処理

XXXX YYYY

の型のみの型のみの型のみの型のみ

流通を許容流通を許容流通を許容流通を許容

の型のみの型のみの型のみの型のみ

流通を許容流通を許容流通を許容流通を許容

の中に何がどのように入っての中に何がどのように入っての中に何がどのように入っての中に何がどのように入って

いるか、ユーザが意識いるか、ユーザが意識いるか、ユーザが意識いるか、ユーザが意識

・ユーザはデータへのアクセスが容易・ユーザはデータへのアクセスが容易・ユーザはデータへのアクセスが容易・ユーザはデータへのアクセスが容易

・全ての型定義を設計時に実施・全ての型定義を設計時に実施・全ての型定義を設計時に実施・全ての型定義を設計時に実施

・設計時に型定義が不要・設計時に型定義が不要・設計時に型定義が不要・設計時に型定義が不要

・データへのアクセスを各処理で実施・データへのアクセスを各処理で実施・データへのアクセスを各処理で実施・データへのアクセスを各処理で実施

CamelCamelCamelCamelはこの方法はこの方法はこの方法はこの方法



Camelの使い方
～メッセージ形式～

� メッセージは“Header”と“Body”から

メッセージ

Header

Body

データ以外の情報を格納

流通データを格納

メッセージの構成

Exchange

※：実際はExchange内に2つのメッセージがある(InMessage、OutMessage)



Camelの使い方
～メッセージ形式 Header～

� データ以外の情報がHeader部に詰まっている

�例えば、ファイル名やディレクトリ名を格納

�「キー＝値」の形式で格納

�プロトコル毎に格納されるキーが異なる

�ユーザが自由に追加/変更可能

メッセージ

Header

Body

[CamelFilePath=C:¥work¥abc¥File.txt]
[CamelFileLength=320]
[CamelFileLastModified=yyyy/mm/dd]
…

[Content-Type=text/xml;charset=UTF-8]
[operationNameSpace=http://ws.test.co.jp/]
[operationName=helloEcho]
…

ファイル受信時のヘッダ情報の例 Webサービス受信時のヘッダ情報の例



Camelの使い方
～メッセージ形式 Body～

� Body部には流通データが詰まっている

�流通するデータを格納

�データの格納方法はプロトコルで異なる

�データ以外の情報を格納しているプロトコル

もある

メッセージ

Header

Body

◆クラス名は

org.apache.camel.component.file.GenericFile

◆処理対象のファイル情報を格納

◆クラス名は

org.apache.cxf.message.MessageContentsList

◆受信データのリスト、引数のデータが格納

ファイル受信時のBody部 Webサービス受信時のBody部



Camelの使い方
～データ変換～

� 容易にBody部のデータ取得する方法を提供

ファイル

入力処理

処理X
ファイル

出力処理

データアクセス手段がないと…

・メッセージの中のデータへのアク

セス手段を各処理で実装する必要が

ある

publicpublicpublicpublic classclassclassclass Process implementsimplementsimplementsimplements Processor {

publicpublicpublicpublic voidvoidvoidvoid process(Exchange exchange) throws throws throws throws Exception {

String data = exchange.getIn().getBody(String.classclassclassclass);

…

publicpublicpublicpublic classclassclassclass Process implementsimplementsimplementsimplements Processor {

publicpublicpublicpublic voidvoidvoidvoid process(Exchange exchange) throws throws throws throws Exception {

String data = exchange.getIn().getBody(String.classclassclassclass);

…

ExchangeExchangeExchangeExchange InMessageInMessageInMessageInMessage BodyBodyBodyBody部を部を部を部をStringStringStringStringでくれ！でくれ！でくれ！でくれ！

処理XはメッセージのBody
部がStringかbyte[]か

InputStreamか知らなくて
もアクセスできる

「処理X」でのデータアクセス手段



Camelの使い方
～データ変換～

� TypeConverterによる変換

ファイル

入力処理

処理X

Header

Body

メッセージ

Object->Byte

Map->Set

byte[]->String

byte[]->Document

File->InputStream

File->String

Body部は
byte[]で主力

Body部は
Stringを期待

TypeConverterによる自動型変換を実施

出力と入力でBody部
の型が不一致の場合

Body部は
byte[]

TypeConverterに
存在しない型変換が

必要な場合は、

ユーザが作成する

ことも可能



Camelの使い方
～実際にやってみる～

� 例えば…
ファイルをコピーする処理を考えてみる

フォルダからフォルダからフォルダからフォルダから

ファイルをファイルをファイルをファイルを

取得する取得する取得する取得する

フォルダにフォルダにフォルダにフォルダに

ファイルをファイルをファイルをファイルを

出力する出力する出力する出力する

ファイルコピー処理
ファイルコピー処理



Camelの使い方
～Javaで書いてみる～

� Javaでも簡単に記述可能

publicpublicpublicpublic staticstaticstaticstatic voidvoidvoidvoid main(String args[]) throwsthrowsthrowsthrows Exception {
File inboxDirectory = newnewnewnew File("data/inbox");
File outboxDirectory = newnewnewnew File("data/outbox");
outboxDirectory.mkdir();
File[] files = inboxDirectory.listFiles();
forforforfor (File source : files) {
File dest = newnewnewnew File(outboxDirectory.getPath() + File.separator + source.getName());
copyFile(source, dest);

}
}
privateprivateprivateprivate staticstaticstaticstatic voidvoidvoidvoid copyFile(File source, File dest) throwsthrowsthrowsthrows IOException {
OutputStream out = newnewnewnew FileOutputStream(dest);
bytebytebytebyte[] buffer = newnewnewnew bytebytebytebyte[(intintintint) source.length()];
FileInputStream in = newnewnewnew FileInputStream(source);
in.read(buffer);
trytrytrytry {
out.write(buffer);

} finallyfinallyfinallyfinally {
out.close();
in.close();

}
}

publicpublicpublicpublic staticstaticstaticstatic voidvoidvoidvoid main(String args[]) throwsthrowsthrowsthrows Exception {
File inboxDirectory = newnewnewnew File("data/inbox");
File outboxDirectory = newnewnewnew File("data/outbox");
outboxDirectory.mkdir();
File[] files = inboxDirectory.listFiles();
forforforfor (File source : files) {
File dest = newnewnewnew File(outboxDirectory.getPath() + File.separator + source.getName());
copyFile(source, dest);

}
}
privateprivateprivateprivate staticstaticstaticstatic voidvoidvoidvoid copyFile(File source, File dest) throwsthrowsthrowsthrows IOException {
OutputStream out = newnewnewnew FileOutputStream(dest);
bytebytebytebyte[] buffer = newnewnewnew bytebytebytebyte[(intintintint) source.length()];
FileInputStream in = newnewnewnew FileInputStream(source);
in.read(buffer);
trytrytrytry {
out.write(buffer);

} finallyfinallyfinallyfinally {
out.close();
in.close();

}
}



Camelの使い方
～Camelでやってみる～

� Camelの場合（Java DSL)
publicpublicpublicpublic staticstaticstaticstatic voidvoidvoidvoid main(String args[]) throwsthrowsthrowsthrows Exception {

//1：最初にCamelContextを作成する
CamelContext context = newnewnewnew DefaultCamelContext();
RouteBuilder routeBuilder = newnewnewnew FileToFileRoute();
context.addRoutes(routeBuilder);

//2:作成したCamelContextを開始し、10秒後に終了する
context.start();
Thread.sleep(10000);
context.stop();

}

publicpublicpublicpublic staticstaticstaticstatic voidvoidvoidvoid main(String args[]) throwsthrowsthrowsthrows Exception {

//1：最初にCamelContextを作成する
CamelContext context = newnewnewnew DefaultCamelContext();
RouteBuilder routeBuilder = newnewnewnew FileToFileRoute();
context.addRoutes(routeBuilder);

//2:作成したCamelContextを開始し、10秒後に終了する
context.start();
Thread.sleep(10000);
context.stop();

}

publicpublicpublicpublic classclassclassclass FileToFileRoute extendsextendsextendsextends RouteBuilder {

@Override
publicpublicpublicpublic voidvoidvoidvoid configure() throwsthrowsthrowsthrows Exception {
from("file:data/inbox?noop=true")

.to("file:data/outbox");
}

publicpublicpublicpublic classclassclassclass FileToFileRoute extendsextendsextendsextends RouteBuilder {

@Override
publicpublicpublicpublic voidvoidvoidvoid configure() throwsthrowsthrowsthrows Exception {
from("file:data/inbox?noop=true")

.to("file:data/outbox");
}



Camelの使い方
～要件の考慮～

� ところが、普通はもっと要件が複雑…
例えば、

� 1分毎にファイルがあるかチェックすること

� 出力ファイル名には日付を付与すること

� .docの付いた拡張子は無視すること

� 同一のファイル名がある場合は無視すること

� サブフォルダも検索すること

� コピーでなく移動に変更。バックアップも取って！

� etc…



Camelの使い方
～追加要件への対応～

� Camelの場合、オプション追加で対応可能

publicpublicpublicpublic classclassclassclass FileToFileRoute extendsextendsextendsextends RouteBuilder {

@Override

publicpublicpublicpublic voidvoidvoidvoid configure() throwsthrowsthrowsthrows Exception {

from(“file:data/inbox? delay=60000 & exclude=*.doc$ & move=.done &

noop=false & idempotent=true & recursive=true")

.to("file:data/outbox? fileName=${date:now:yyyy-MM-dd}_${file:name}");

}

publicpublicpublicpublic classclassclassclass FileToFileRoute extendsextendsextendsextends RouteBuilder {

@Override

publicpublicpublicpublic voidvoidvoidvoid configure() throwsthrowsthrowsthrows Exception {

from(“file:data/inbox? delay=60000 & exclude=*.doc$ & move=.done &

noop=false & idempotent=true & recursive=true")

.to("file:data/outbox? fileName=${date:now:yyyy-MM-dd}_${file:name}");

}

1分毎にファイルがあるかチェック

出力ファイル名には日付を付与

.docの付いた拡張子は無視

同一のファイル名がある場合は無視

サブフォルダも検索

コピーから移動に変更

.doneフォルダにバックアップ



さいごに（その①）

～様々な立場におけるApache Camel～

�インテグレータ View
� 安価なシステム提案

→イニシャルコストなし

→ランニングコストはメンテナンスに必要な稼動を請求！？

� 国内でApache Camel先駆者となれる
→国内での利用ユーザはほんの僅か、

使い倒してライバルとの差別化！？

� 容易な開発体制の確立

→専門技術者を集める必要なし、Java技術者にて開発可能



さいごに（その①）

～様々な立場におけるApache Camel～

�エンドユーザ View
� 安価なシステム構築

→イニシャルコストなし

→必要なのはメンテナンス費用（≒保守費）

→ポジティブに考えるといつでも捨てれる！？

→ OSSの積極的な利用によるコストダウン体制をアピール



さいごに（その②）

～ユーザ会を立ち上げました～

� 皆さんにCamelを知って欲しい！

� 日本Apache Camelユーザ会

【お勉強系サイト】

http://sourceforge.jp/projects/cameluserjp/

【キャラ系サイト】

https://sites.google.com/site/jaacug/

� 主な活動内容

� Camelのドキュメント翻訳

� Camelのサンプル実装

等をやりたいと思っています。



ご静聴

ありがとうございました


